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Curriculum, including, without limitation, warranties of merchantability, fitness for a particular purpose, or non-infringement. The Evaluator acknowledges that the entire risk arising out of use or performance of the 
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LIMITATIONS OF LIABILITY 
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Project Overview 
 

Introduction to TechnoEntrepreneur 

In this project, students become entrepreneurs who operate their own 

restaurant. The fun begins, when the fledging restaurateurs survey their 

classmates to learn about the type of cuisine to serve their patrons. The survey 

data is arranged in Microsoft Excel and the numbers transformed into a graph. 

This information is then used to explain the new business venture to potential 

investors in a well-written letter. Once students generate enough money to 

start-up their restaurant, they use the drawing tools in Microsoft Word to draft 

the floor plan. The business idea is really starting to take shape! 

 

Soon the entrepreneurs' dreams become a reality - their restaurant is opened to the public and 

it is a huge success. The restaurateurs use Microsoft Excel to calculate their earnings. The business 

is making enough money that it is time to expand the operation. Students create a newsletter to 

promote their restaurant concept as an excellent business opportunity for like-minded 

entrepreneurs.  

 

What type of restaurant will you operate? 

 

 

Students complete the following tasks: 

 

1. In Session 1, students become entrepreneurs. They organize the start-up of their business 

venture – to own and operate a restaurant. To begin, they are introduced to spreadsheets 

and gain an understanding of how this tool is used by „real‟ professionals. They then survey 

their classmates to determine the type of cuisine to serve at their restaurant. With this data, 

students tabulate and chart the results using Microsoft Excel. This information is interpreted 

and summarized in a report to potential investors in the following session. 

2. In Session 2, students develop a business plan. By interpreting the survey results from last 

session, students determine the type of restaurant they would like to own and operate. With a 

firm idea, they write a professional letter to an investor requesting money to generate 

revenue to use towards start up business costs. Students learn how to use a Microsoft Word 

template to quickly write a well-formatted document. They insert the Microsoft Excel 

worksheet from the previous session into their letter to illustrate the results of their survey and 

their rationale for selecting a particular type of cuisine for their restaurant. 

3. In Session 3, students receive confirmation that they have acquired enough money to start 

their business venture. The investor has requested a floor plan of the restaurant and 

permission to make some suggestions with the design. Students launch Microsoft Word and 

explore its drawing tools in order to acquire the skills necessary to complete this task. 

4. In Session 4, students apply the drawing tools of Microsoft Word to design the floor plan of 

their restaurant. Students consider their clientele and the type of dining experience they are 

expecting. Shortcuts to complete the project are introduced as students design seating 

arrangements that can be easily grouped and duplicated to place elsewhere in the layout. 

Students create a well designed restaurant with a focus on functionality. 
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5. In Session 5, students learn advanced spreadsheet skills by designing a worksheet to 

calculate their monthly, quarterly, and yearly earnings. Using Microsoft Excel students use the 

Fill Series option to easily create a table that holds financial information. Calculations such as 

Sum and Average give students a clear overview about their earnings. This information is then 

displayed in chart format. 

6. In Session 6, students complete a newsletter to help promote their entrepreneurial venture in 

the restaurant business. The newsletter includes the company logo, contact information, 

financial statistics, a monthly earnings chart, and an attractive description of the restaurant 

complete with floor plan.  

 



 

 

$
 

SESSION 1 
BUSINESS SURVEY 
In this session, students become entrepreneurs. They organize the start-up of 

their business venture – to own and operate a restaurant. To begin, they are 

introduced to spreadsheets and gain an understanding of how this tool is used 

by „real‟ professionals. They then survey their classmates to determine the type 

of cuisine to serve at their restaurant. With this data, students tabulate and 

chart the results using Microsoft Excel. This information is interpreted and 

summarized in a report to potential investors in the following session. 

 

 
Assignment 1 - Introduction to TechnoEntrepreneur 

Assignment 2 - The Microsoft Excel Window 

Assignment 3 - Business Survey 

Assignment 4 - Business Survey Results 

Session 1 Review  

Session 1 Skill Review 

Session 1 Extension Activity 
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Session 1: Business Survey 

GETTING STARTED 
 

Overview 

In this session, students become entrepreneurs. They organize the start-up of their business 

venture – to own and operate a restaurant. To begin, they are introduced to spreadsheets and 

gain an understanding of how this tool is used by „real‟ professionals. They then survey their 

classmates to determine the type of cuisine to serve at their restaurant. With this data, students 

tabulate and chart the results using Microsoft Excel. This information is interpreted and 

summarized in a report to potential investors in the following session. 

 

 

Materials 

 Microsoft Office Excel 

 Microsoft Office Excel Standard Toolbar Flashcards (Optional) 

 Entrepreneur template 

 My Survey sample file  

 Restaurant Name Survey sample file for Skill Review (Optional) 

 

 

Teacher Preparation 

 The Entrepreneur folder must be copied to each workstation before instruction begins. 

This folder contains the templates necessary to complete the activities in this project. 

Detailed instructions of how to prepare the folder are discussed the in the Preparing to 

Teach section of this guide. 

 (Optional) Print in color the flashcards outlined in the Preparing to Teach section of this 

guide. Separate and mount or laminate each card to increase durability. These 

flashcards can be used to create bulletin boards or used to predict or review the 

function of program tools. 

 

 

Teaching Strategy 

 

In this project, students become entrepreneurs. Explain scenario to students: 

 

You are going to own and operate a restaurant. The first decision you will 

need to make is which cuisine, or type of food, you would like to feature in 

your restaurant. The best way to do this is to survey a group of people to find 

out which cuisine is most popular. If you serve the type of food which people 

really like, your restaurant will make money and be successful. 
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In this session, students learn about the role of an entrepreneur. Discuss the following: 

 

What is an entrepreneur? An entrepreneur is an individual who starts his or 

her own business. Starting a business is a busy time in any entrepreneur's life. 

Critical steps can be easily overlooked until the process is well underway. 

The number one criterion for success is having a good plan. Starting and 

running a business is supposed to be fun. This is a chance to be in charge 

and live a dream where time is spent doing something you are really 

passionate about! 

 

You will become an entrepreneur by owning and operating your own specialty restaurant. 

This is a restaurant that specializes in a particular type of food, such as pizza, hamburgers, 

tacos, donuts and so on. To begin your business venture you will conduct a survey of your 

peers to learn about food preferences. The survey results help you to determine the cuisine to 

serve at your restaurant. 

 

Afterwards, you will use a spreadsheet program to organize the information from your survey. 

You will be able to change your results easily into a variety of graphs. These graphs will show, 

in a very clear pictorial way, which type of restaurant is most popular. 

 

 

Assignment 1 Introduction to TechnoEntrepreneur 

 

In this assignment, students are introduced to the concepts of entrepreneurs and spreadsheets. 

The assignment helps students understand how useful a spreadsheet program is for a business 

owner. Prior to beginning, introduce the following terms: 

 

 Entrepreneur: a person who starts and runs their own business 

 Spreadsheet: a computer program that organizes numerical information and can 

perform mathematical functions 

 

 

Assignment 2 The Microsoft Excel Window 

 

In this assignment, students learn the basic parts of a spreadsheet window, how to select cells, 

and how to enter text. If your students are familiar with spreadsheets, you may use this 

assignment as a review, or simply omit it. Prior to beginning, introduce the following terms: 

 

 Columns: Vertical groups of cells in a worksheet. The gray area at the top of each 

column is called a column heading. Column headings are labeled alphabetically.  

 Rows: Horizontal groups of cells in a worksheet. The gray area at the left of each row is 

called a row heading. Row headings are labeled with numbers. 

 Cells: A box where a row and column intersect is called a cell. Cells can hold words, 

numbers, or formulas. Each cell has a cell reference, which is the unique name or 

address assigned to the cell. A cell reference is based on its column and row location in 

the worksheet. For example, the cell reference for the cell that intersects column A and 

row 1 is A1.  

$
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Assignment 3 Business Survey 

 

In this assignment, students prepare to start their restaurant business by conducting a class 

survey. They poll their classmates in order to find out the most popular type of restaurant cuisine. 

If you wish to view an example of a completed graph, look at the My Survey file in the Sample 

File folder of Session 1. You may also wish to show the sample file to the students for them to 

understand what they are going to create. 

 

Prior to beginning, introduce the following term: 

 

 Survey: a method of collecting data in which people are asked to answer a number of 

questions related to a specific topic 

 

Students ask their classmates which food they prefer to eat when dining at a restaurant. 

Students may add a fifth type of restaurant cuisine in the "Other" box (upon teacher approval). 

Results are recorded by placing a pencil stroke (I) in the appropriate column for each response 

received. (I =1 response, II = 2 responds, III = 3 responses, and so on). Once each person in the 

class has been polled, students tally the results and write the total for each cuisines type in the 

“Total” column. 

 

 

Assignment 4 Business Survey Results 

 

In this assignment, students transfer the restaurant cuisine information from their handouts to a 

Microsoft Office Excel spreadsheet.  

 

Prior to beginning, discuss the following term: 

 

 Graph: A picture created from a set of numbers. A graph shows patterns that are 

harder to recognize by just looking at the numbers themselves. Some kinds of graphs 

are a line graph, a bar graph, and a pie chart.  

 

You may find it useful to demonstrate the Chart Wizard to the class, as a group. Illustrate to the 

students how to select multiple cells, or a data series, before clicking the Chart Wizard. In this 

way, the computer knows which data is being used to generate the graph. Encourage the 

students to explore the variety of possibilities of graphs. Discuss the uses and advantages of 

different types of graphs. Discuss with the class which types of graphs would best fit which kind of 

numerical information. For example, line graphs are best used to show changes over time, bar 

graphs are best used to compare sets of information to each other, and circle graphs or pie 

charts are best used to compare the relationship of parts to a whole. 

 

Collect the printed copies of the worksheet from the students at the end of the session. You may 

wish to start a file folder for each student that contains the printed material from 

TechnoEntrepreneur. Students will also be printing a letter in Session 2, floor plan in Session 4 and 

a spreadsheet in Session 5. It is important to keep the printouts because, students will need to 

refer to the information when they develop a worksheet to calculate business earnings in Session 

5 and a newsletter in Session 6. 
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Lesson Plan 

Assignment 1 - Introduction to TechnoEntrepreneur 

 

 What is an entrepreneur? 

 How does a spreadsheet program help an entrepreneur? 

 Spreadsheets and you.  

 

Assignment 2 - The Microsoft Excel Window 

 

 Open Microsoft Excel. 

 Label the parts of the Microsoft Excel window. 

 Learn basic spreadsheet skills. 

 Close Microsoft Excel.  

 

Assignment 3 - Business Survey 

 

 Survey classmates to determine the most popular restaurant cuisine. 

 

Assignment 4 - Business Survey Results 

 

 Open the Entrepreneur template. 

 Enter the Business Survey results. 

 Select the data series to be graphed. 

 Create a pie chart using the Chart Wizard. 

 Move and resize the graph. 

 Identify your work. 

 Save and print a workbook. 

 Close the Microsoft Office Excel. 

 

 

Learning Objectives 

Below is a list of the learning objectives for this session. Students should be able to independently 

complete each task. 

 

Content Knowledge: 

 conduct a survey 

 define the terms worksheet, column, column heading, row, row heading, cell, cell 

name, name box, and formula bar 

 explain the role of an entrepreneur 

 recognize the purpose of a spreadsheet program and how it can be used in the 

workplace 
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Technical Skills: 

 

Operating Environment 

 close a program 

 create a student folder and subfolder 

 open a Microsoft Excel template 

 save a Microsoft Excel workbook to the student folder 

 print a worksheet 

 

 Applied Technology 

 organize survey data using spreadsheets 

 

 Spreadsheet 

 convert the data labels from a value to a percent 

 enter text into a cell by either typing it directly into the box or into the formula bar 

 fill a cell with color using the Fill Color tool 

 graph the results using the Chart Wizard 

 position the chart on a worksheet 

 position the legend in the chart 

 preview and select a pie chart type 

 resize the chart 

 select a cell using the mouse pointer, enter key, tab key, and name box 

 select a specific cell by the cell name 

 select columns using the use pointer, shift key, and ctrl key 

 select data series to appear in the pie chart 

 select multiple cells and remove the fill color 

 select rows using the use pointer, shift key, and ctrl key 

 type a title for the chart 

 

 



BUSINESS SURVEY 

 

1-6 TECHNOKIDS INC. 



TECHNOENTREPRENEUR SESSION 1 

 

TECHNOKIDS INC. 1-7 

Assignment 1: Introduction to TechnoEntrepreneur 

 

What is an Entrepreneur? 

An entrepreneur is a person who starts and runs their own business. The business may be a store, 

restaurant, hair dressing salon, or any other type of money making venture. An entrepreneur is 

responsible for all aspects of starting up a company. They need to be able to plan their ideas, 

raise money to begin the business, operate the company once it is open, calculate the financial 

data, and continue to get others to invest in the idea. Although it is a lot of hard work and 

financial risk, it is a rewarding job. There is no boss to tell the entrepreneur what to do, because 

they work for themselves. 

 

How does a Spreadsheet Program Help an Entrepreneur? 

What are Spreadsheets? 

 

Spreadsheets are a grid made up of rows and columns that are used to record 

information. One of the most common types of spreadsheet programs is 

Microsoft Excel. The great advantage of using a spreadsheet on a computer, 

instead of a paper ledger, is that it is much easier to add, change, calculate, 

graph, and analyze data. 

 

How does Microsoft Excel Help an Entrepreneur? 

 

Microsoft Excel lets an entrepreneur easily: 

 

 Record Data: add information into the spreadsheet. 

 Calculate Data: use formulas to quickly add, subtract, divide, multiple, count, 

average, and do many other calculations. 

 Create Graphs: graph the data to make pie, bar, line, and many other types of 

charts. 

 Make Data Look Good: format the text, fill color of cells, or add borderlines to make 

the information look attractive and easy to read. 

 Share Information with Others: information in a spreadsheet can be printed or 

copied into other programs like Microsoft Word, making it easy to share information. 

 Store Data: data is stored in workbooks that contain many worksheets. 

You are beginning the project TechnoEntrepreneur. 

 

An entrepreneur is someone who starts and runs their own 

business. In your case, you are going to operate a 

restaurant.  

 

Read to learn about how Microsoft Excel can help you 

organize your business. 

S
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Spreadsheets and You 

1. How do you use a spreadsheet program? 

  

  

  

 

 

 

2. What spreadsheet programs have you used in the past? 

  

 

 

 

 

3. Why do you think you will be a good entrepreneur? 
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In this assignment you learn the parts of the Microsoft Excel 

window. Label the parts of the window below using the 

descriptions on the next page. 

Assignment 2: Spreadsheet Basics 
 

 

 

Open Microsoft Excel 

 Double click the Microsoft Excel shortcut OR click START – All 

Programs – Microsoft Office – Microsoft Office Excel. 

 

 

Label the Parts of the Microsoft Excel Window 

 

1. Title Bar  5. Name Box  9. Scroll Bars 

2. Menu Bar  6. Worksheet Window  10. Sheet Tabs 

3. Standard Toolbar  7. Help  11. Formula Bar 

4. Formatting Toolbar  8. Task Pane  
 

 

      
 

 
 

1 

2 
3 

4 

6 

8 

10 

9 

5 

7 

Terms: 

 
 Title Bar 

 Menu Bar 

 Standard Toolbar 

 Formatting Toolbar 

 Name Box 

 Worksheet Window 

 Help 

 Task Pane 

 Scroll Bars 

 Sheet Tabs 

 Formula Bar 

11 
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Parts of the Microsoft Excel Window: 

 

 

 

Title Bar  A bar at the top of the window that shows the name of the 

document, program name, and the control buttons. 

Menu Bar  A bar below the title bar that holds the menus including File, Edit, 

View, Insert, Format, Tools, Data, Window, and Help. Each menu 

contains a list of program options. 

Standard Toolbar Displays the most common tools used when creating a document. This 

includes tools to manage a file, graph data, or change the view. 

Formatting Toolbar Displays tools used to format text in a document. This includes tools to 

change the font, adjust the alignment, or add borderlines.  

Name Box A box that shows the address of the active cell.  

Worksheet Window  A grid in the center of the window. It is made up of rows and columns 

that form cells. In the cells, words and numbers can be added.  

Help A box at the top right corner of the window that gives help with the 

program. Answers are listed when a question is entered into the box.  

Task Pane  A box on the right edge of the window that displays program or tool 

options. The task pane opens automatically when you do certain 

tasks, such as start a new document, ask for help, or insert clip art. 

Scroll Bars  Scroll bars let you change the part of the worksheet shown in the 

window. The worksheet can be moved up or down using the vertical 

scroll bar, or to the left and right using the horizontal scroll bar. 

Sheet Tabs Tabs that let you change the active worksheet in the window. 

Formula Bar A bar that lets you add, edit, or calculate data.  
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An entrepreneur needs to know how to use a spreadsheet program. 

Follow the instructions to learn basic terminology and functions. 

Learn Basic Spreadsheet Skills 

 

Working with Columns 

Columns are vertical groups of cells. The gray area at the top of each 

column is called a column heading. Column headings are labeled 

alphabetically. The worksheet only shows a few columns, but Microsoft Excel 

has a total of 256 columns. 

 

 

 

 Click on column heading A. 

 Click on column heading C. 

 Click on column heading E. 

 

1. What happens when you click on the column headings? 

 

The individual column is selected when the column heading is clicked. 

 

 

 

 Now, click on column heading A, hold down the SHIFT key, and then click the column 

heading D. 

 

2. What happens when you click on the column headings? 

 

Columns A, B, C, and D become selected. 

 

 

 

 Click on column heading A, hold down the CTRL (Control) key, and then click the column 

C and column E headings. 

 

3. What happens when you click on the column headings? 

 

Columns A, C, and E are selected only. 

column 

column heading 
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Working With Rows 

Rows are horizontal groups of cells. The gray area to the left of each row is called a row 

heading. Row headings are labeled numerically. The worksheet only shows a few rows, but 

Microsoft Excel has a total of 65 536 rows. 

 

 
 

 

 Click the row heading 5. 

 Click the row heading 10. 

 Click the row heading 15. 

 

4. What happens when you click on the row headings? 

 

The individual row is selected when the row heading is clicked. 

 

 

 

 

 Now, click the row heading 5, hold down the SHIFT key and then click the row heading 10. 

 

5. What happens when you click on the row headings? 

 

Rows 5, 6, 7, 8, 9 and 10 become selected. 

 

 

 

 

 Click the row heading 1, then hold down the CTRL key and click row headings 5 and 10 to 

select only rows 1, 5, and 10. 

 

6. What happens when you click on the row headings? 

 

Rows 1, 5, and 10 are selected only. 

 

 

 

row 

row heading 
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Working With Cells 

A cell is where a column and row meet. Cells can hold words, numbers, or formulas. Each cell 

has a name called a cell reference. The cell reference is shown in the name box. A cell 

reference is the column and row location. For example the cell reference for the cell that 

intersects column A and row 1 is A1.  

 

 
 

 

 With the mouse pointer click on cell A1 to select it. 

 Move the mouse pointer to column D, then count down 2 cells and click to select the 

cell. 

 

7. Look in the name box. What is the cell name? 

 

D2 

 

 

 

 

 

 

How to Enter Text 

 With cell A1 selected, type hello. 

 Your worksheet should look like this picture: 

 

 
 

 

 Click the mouse at the end of hello in the formula bar. 

 Press the SPACEBAR once and type the word there. 

name box 

formula bar 

cell 

cell 
You can add text by typing in 

the cell or in the formula bar. 
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Move from Cell to Cell 

 Press the ENTER key to move from cell A1 to cell A2. 

 Press the TAB key to move from cell A2 to cell B2. 

 Use the mouse pointer to move to cell C3. 

 Highlight C3 in the Name Box. Type B4, and then press ENTER to select cell B4. 

 

 
 

 

 

Close Microsoft Excel 

 Click the Close button (X) or select Exit from the File menu. 

 

You can select a cell by using 

the ENTER key, TAB key, mouse 

pointer, or the name box. 

S
A
M

P
LE



TECHNOENTREPRENEUR SESSION 1 

 

TECHNOKIDS INC. 1-15 

Assignment 3: Business Survey 
 

 

To organize the start-up of your restaurant business venture, you must 

survey your classmates to find out the type of food or “cuisine” they like 

to eat when at a restaurant. The results of the survey will be put into a 

spreadsheet using Microsoft Excel. The information will be used later to 

create a report to try to raise money to start the company. 

 

To begin the survey, ask your classmates what food they like to eat 

when dining out. Place a pencil stroke (I) for each response in favor of 

a particular cuisine type in its Tally column. When complete, calculate 

the results of each type by adding the tally marks together and 

recording each amount in the Total column. 

 

 

Restaurant Cuisine Tally Total 

Italian 

  

Steakhouse 

  

Mexican 

  

Seafood 

  

Other:  
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Assignment 4: Business Survey Results 
 

 
 

Open the Entrepreneur Template 

 To open the template, double click on the shortcut to the 

Entrepreneur folder OR ask your teacher how to get to the 

folder. 

  

 Double click the Entrepreneur file to open it. 

 
 

Enter Business Survey Results 

 Make sure that the Business Survey worksheet is active. 

 Select cell C5. Type in the total number of people for Italian cuisine using the information 

from the Business Survey assignment. 

  

 Press the ENTER key. 

 Continue to add the survey results using the information from the Business Survey 

assignment. 

Now that you have discovered which type of food your 

classmates prefer, you are going to put this information into a 

spreadsheet. In a few easy steps, you can create a clear 

picture, or graph, of the results. 
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Create a Pie Chart Using the Chart Wizard 

 

Select the Data Series and then Activate the Chart Wizard 

 Click the mouse pointer in cell B5. 

 Hold the mouse button down and drag to include cell C9. 

  

 Click the Chart Wizard button on the Standard toolbar. 

 

Step 1: Select a Chart Type 

 In the Chart type area, choose Pie. In the Chart sub-type area select an option. 

 To view the option, click the Press and Hold to View Sample button. 

 

 After a chart is selected, click Next to display step 2 of 4. 

Selected Data Series 

A pie graph is a chart that divides a 

circle into parts. The circle is like a 

“pie”. Each piece of data is shown as 

a slice of the pie.  

 

The whole pie is100%. Each bit of 

data is shown as a fraction of the 

whole pie.  

 

The size of the pie piece depends on 

how many people liked the cuisine 

type - The more people who like the 

food, the bigger the piece. 

A graph or chart is a picture or diagram that shows numerical 

information in a clear, understandable way. In this activity, you will 

make a pie chart from the numbers and words you entered in the 

spreadsheet.  
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Step 2: Identify the Categories 

 Make certain the Columns radio button is selected. 

 

 Click Next to display step 3 of 4. 

 

 

Step 3: Add Title and Place the Legend 

 Click the Titles tab. In the Chart Title box type Restaurant Cuisine Preferences. 

 

 Click the Legend tab. Make sure that the Show Legend option is selected with a check 

mark ().  

 Select the placement of the legend – Bottom, Corner, Top, Right or Left. 

 

 
Click in the Show 

Legend check box. 

Pick a place for the 

legend. 
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 Click the Data Labels tab. 

 Select Percentage. 

 
 

 Click Next to display step 4 of 4. 

 

Step 4: Place Chart on Worksheet 

 In the Place chart: area, choose As object in: Business Survey. 

 
 

 Click Finish to insert the chart into the Business Survey worksheet. 

 

Click As object in: 

You can see the 

cuisine that 

people like the 

most. It is the 

biggest pie 

piece. 
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Move the Graph 

 With the graph selected, move the mouse pointer on the chart area (background) of the 

graph. 

 
 

 Click and drag the graph until it rests below the Business Survey table. 

 Use the scroll arrows on the right of the window to change the part of the spreadsheet in 

view, if necessary. 

 

 

Resize the Graph 

 Move the mouse pointer over the bottom right selection handle on the graph. 

 Click and drag the corner to change the chart to the desired size. 

 For example: 

    
 

 

Graphs are a great way to give a 

clear, effective picture of 

numerical information. Instead of 

looking through rows of numbers, 

you can easily see the data in a 

picture. 
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Identify Your Work 

 Select cell A1. Type Student Name.  

 

 

Save a Workbook 

 To save a document click the Save button on the Standard toolbar. 

 Click the drop down arrow beside the Save in: box and go the place where 

you save your work. 

 Click the Create New Folder button in the Save As dialog box. 

 

 

 Type Entrepreneur in the Name box.  

 
 

 Click OK. 

 When the Save As dialog box reappears, type in the filename My Survey. 

 
 

 Click the Save button. 
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Print the Worksheet 

 Print the worksheet by selecting Print from the File menu. 

 
 

 In the Print what box select Active sheet(s). 

 Click OK to send the document to the printer. 

 Give the printed survey to your teacher. 

 

 

Close Microsoft Office Excel 

 Click the Close button to exit the program. 

 

 

 
 

 

You will be using this research information and the 

graph in the next session. Now that you know the 

type of food the majority of people prefer, you will 

need to write a letter to borrow money for your 

restaurant. Including this spreadsheet information in 

your letter will make it look professional and 

convincing. S
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SESSION 1 REVIEW 
 

Match the term to its definition. 

 

 

 

1. survey a) a computer program that organizes numerical 

information 
E 

 

 

2. entrepreneur b) a single page of a spreadsheet workbook G 

 

 

3. spreadsheet c) a picture created from a set of numbers A 

 

 

4. graph d) one box of a spreadsheet grid C 

 

 

5. worksheet 
e) a method of collecting data in which people are asked 

to answer a number of questions related to a specific 

topic 

B 

 

 

6. cell f) vertical lines of cells in a worksheet D 

 

 

7. column g) a person who organizes and operates their own 

business 
F 

 

 

8. row h) horizontal lines of cells in a worksheet H 
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SESSION 1 SKILL REVIEW 
 

The name of your restaurant is very important. If the name is popular, clear and 

unforgettable for your customers, your business has a greater chance of being 

a success. Follow the directions to generate a variety of names, survey their 

popularity, and graph the results. 

 

 

Make Up Names 

 

1. Using your imagination, write 5 different possibilities for names for your new restaurant. 

Here are some guidelines: 

 

 the name should make it clear that the business is a restaurant 

 the name should indicate what type of food the restaurant serves 

 the name should be catchy and something that a customer can easily remember 

 

 

Survey Your Classmates 

 

2. Show the names of your restaurant to a classmate. Ask them to choose their favorite 

one. Keep a tally list of the favorites. Ask as many classmates as you can for their 

opinions. 

 

 Name of Restaurant  Tally 

    

    

    

    

    
 

 

 

 

Create a Spreadsheet 

 

3. Open Microsoft Excel. 

4. Label one column Name and the next column 

Number. 

5. Write the possible names of your restaurant in the first 

column. 

6. Make the Name column wider by dragging the 

border of the column heading until the names fit. 

7. Write the total number of tallies in the second column. 
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Make a Graph 

 

8. Select all the names and totals. 

9. Using the Chart Wizard, create a pie graph. 

10. Add a title, select a placement for the legend, and show the data using 

percentages. 

11. Place the chart as an object in the worksheet. 

12. Move and resize the graph to place it under the spreadsheet chart. 

13. Add your name. 

14. Save the document as Restaurant Name Survey. 

15. Print your work to show which restaurant name was selected by the majority of people. 

 

 

 

 
 

A sample of the Restaurant Name Survey is available in the 

Session 1 Skill Review folder. 
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SESSION 1 EXTENSION ACTIVITY 
 

Comparison of Chart Types 

 

Spreadsheet information can be displayed in a variety of kinds of 

graphs. However, certain types of charts show numerical information 

more clearly than others, depending on what information is being 

presented. Compare different chart types. 

 

Exploring Types of Charts 

 

1. Open the file you created in Session 1 called My Survey. 

2. Click on the first worksheet tab at the bottom called Business Survey. 

3. Select the 5 cuisines and totals and click the Chart Wizard button to make a graph.  

4. Try out the types of charts by clicking on the Press and Hold to View Sample button. 

 
 

5. Make a column graph and a line graph to add to the pie graph you already have. 

 
 

 

6. From the File menu, select Save As. Save this document as Comparing Graphs. 

a.  Which type of graph do you think shows the restaurant cuisine most clearly? Why? 

  

  

b.  Which type of graph do you think shows the favorite cuisine poorly? Why? 
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Which is the Best Fit? 

 

7. Fill in the blanks with the best type of graph for the data. You may wish to have the Chart 

Wizard open to look at samples of the charts. Choose from the following types of graphs: 

 

 

 

 

Column: A column graph is made of bars. Each bar is a piece of data. This type of graph 

is used to compare values.  

 

Line: A line graph is points that are connected to make a line. Each point is a piece of 

data. This type of graph is used to show how something changes over time. 

 

Area: An area graph is points that are connected, with the space between the points 

and x-axis filled with color. Each point is a piece of data. This type of graph is used to 

show changes in values in distance or time. 

 

Pie: A pie graph is a circle that is divided into slices. Each slice of pie is a piece of data. 

This type of graph is used to show how one whole thing is divided into smaller categories. 

 

 

 

a. You are planning how to spend your allowance. You have broken it down into 

categories: long term savings, entertainment, clothing, food, and video games. You are 

creating a graph to show how much of your money is spent in each area. This would best 

be shown using a __________________ graph. 

 

 

b. You are working on a Science assignment on weather. You are comparing the average 

January temperature of 5 major cities in your country. You choose to show this data using 

a __________________ graph. 

 

 

c. In another part of your Science project, you would like to display the changes in 

temperature in your home town over the time period of a year. You use a spreadsheet 

and choose a __________________ graph. 

 

 

d. You are planning a bike trip over hilly terrain. You would like to calculate and graphically 

show the altitude changes. You research the altitudes at each checkpoint and plot them 

using an __________________ graph. 

 

column, line, area, pie 
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SESSION 2 
PROFESSIONAL LETTER 
In this session, students develop a business plan. By interpreting the survey 

results from last session, students determine the type of restaurant they would 

like to own and operate. With a firm idea, they write a professional letter to an 

investor requesting money to generate revenue to use towards start up 

business costs. Students learn how to use a Microsoft Word template to quickly 

write a well-formatted document. They insert the Microsoft Excel worksheet 

from the previous session into their letter to illustrate the results of their survey 

and their rationale for selecting a particular type of cuisine for their restaurant. 

 

 
Assignment 5 - Professional Letter 

Session 2 Review  

Session 2 Skill Review 

Session 2 Extension Activity 
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Session 2: Professional Letter 

GETTING STARTED 
 

Overview 

In this session, students develop a business plan. By interpreting the survey results from last session, 

students determine the type of restaurant they would like to own and operate. With a firm idea, 

they write a professional letter to an investor requesting money to generate revenue to use 

towards start up business costs. Students learn how to use a Microsoft Word template to quickly 

write a well-formatted document. They insert the Microsoft Excel worksheet from the previous 

session into their letter to illustrate the results of their survey and their rationale for selecting a 

particular type of cuisine for their restaurant. 

 

 

Materials 

 Microsoft Word 

 Microsoft Word Standard Toolbar Flashcards (Optional) 

 My Survey printout (created in previous session) 

 Professional Letter template 

 Investment Letter sample file (Optional) 

 Grand Opening sample file for Skill Review (Optional) 

 

 

Teacher Preparation 

 You may wish to view the Investment Letter sample file to see a completed letter. 

 

 

Teaching Strategy 

In this session, students request funds for start-up capital by writing a professional letter to 

potential investors. Explain scenario to students: 

 

To open your own restaurant, you need a large sum of money. You have to 

buy or rent a building, hire employees, and purchase appliances, furnishings, 

and food. As an entrepreneur, you need to convince people, such as family, 

friends, and banks to lend you the necessary capital, or money. By 

explaining your research survey and your well thought out plans, people will 

be more likely to believe that your restaurant will be a success. As a result, 

they may lend you their money and expect to make a good investment. 

 

You will be writing a letter explaining your careful research and detailed plans to potential 

investors. In the letter, you will describe your restaurant and insert a copy of the spreadsheet 

and pie graph that you saved in the last session. Hopefully your investors will be impressed 

with how carefully organized and well prepared you are to start your own business! 

 

 

$
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Assignment 5 Professional Letter 

 

In this assignment, students compose a letter to try to convince people to lend money for the 

opening of the restaurant. To see a sample of a completed letter, view the Investment Letter in 

the Session 2 sample file folder. 

 

Prior to beginning, discuss and interpret the survey results from the previous session with the class 

as a whole. Distribute the printed My Survey document from the last session to the students.  

 

 Examine the chart results. What was the most popular food choice based on survey 

results?  

 Examine the pie chart. Do the results of the chart reflect the results gathered in the 

survey? In the case of a tie, make a decision on the type preferred.  

 What will be on the menu? Consider menu variety – is there a variety of different items 

that can be served to customers?  

 How popular is the selected cuisine? How many other restaurants of the same type 

already exist in your area?  

 What type of restaurant will you open? Discuss some of the possibilities: fine dining, drive 

through, fast food, family restaurant, roadhouse, or delivery only. 

 

Students are now ready to write a letter to potential investors using the template in Microsoft 

Word called Professional Letter. A template determines the basic structure for a document and 

contains document settings such as AutoText entries, fonts, key assignments, macros, menus, 

page layout, special formatting, and styles. Introduce the following term: 

 

 Placeholder: a boundary that defines an area that may contain text or pictures 

 

Discuss the conventional parts of a professional letter with the students: 
 

 Company Name: the letter has a frame where the company name and logo should 

appear. A logo is a graphic symbol or emblem that represents a company. For 

example, the "Golden Arches" represent McDonald's fast food restaurants, or the blue 

and red circle that represents Pepsi Cola. 

 Return Address: beside the company name is a text box, or an area that will contain 

the company address. Students key in a home or fictional address for the location of 

the restaurant. 

 Date: the date is automatically entered on the letter.  

 Recipient's Address: the letter has a placeholder for the address of the person who is 

receiving the letter. Students can type the school address in this section of the letter or 

they should add a fictional address. 

 Salutation: a salutation is a polite expression of greeting at the start of a letter. The 

template has "Dear Sir or Madam" to indicate the name of the letter recipient. This text 

can be changed by right clicking on the selection and choosing another from the list. 

 Body: in the body of the letter students delete the current text. A short letter is 

composed requesting money to pay for the start-up costs of the business venture. 

Students include in the letter an explanation of their survey results as well as a picture of 

the actual Microsoft Excel survey and chart. Students must explain their business plan 

indicating why their restaurant is unique and will attract customers. 

 Closing: the letter ends with the closing "Sincerely". Students can right click on this text 

and select another closing from the displayed options. 
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 Signature: this final section of the letter includes the name of the letter writer as well as 

their job title. 

 

Collect the printed copies of the letter from the students at the end of the session. You may wish 

to start a file folder for each student that contains the printed material from TechnoEntrepreneur. 

Students will also be printing a floor plan in Session 4 and a spreadsheet in Session 5. It is 

important to keep the printouts because students will need to refer to the information when they 

create a newsletter in Session 6. 

 

 
 

 

 

Lesson Plan 

Assignment 5 - Professional Letter 

 

 Open the Professional Letter template. 

 Add a company name. 

 Add a company logo using clip art. 

 Resize the clip art. 

 Add a return address. 

 Add the recipient‟s address. 

 Insert the Microsoft Excel worksheet created in the previous session. 

 Type the body of the letter. 

 Add a letter closing. 

 Add a signature. 

 Save the document. 

 Print the letter. 

 Close Microsoft Office Word. 

Teacher Tip: 

 

Clip Art: When adding clip art to the letter, the template is formatted to add pictures in 

line with text. As a result, students can only resize the clip art but not move or drag it 

anywhere else on the page. This has been done to keep the letter writing steps simpler. If 

students know how to change text wrapping, they will find that the picture can only be 

moved within the placeholder box. 

 

Download Additional Clip Art: You can download additional clipart from the Microsoft 

website. To do this, open the Clip Task Pane. Click Clip art on Office Online at the bottom 

of the pane. When the website opens, type in a keyword to search for images. When you 

find one you like place a checkmark beside the image. Now follow the on-screen 

instructions to download the clip. Please note: your system administrator may have made 

it so you or your students can‟t download clip art. If this is the case, ask them to download 

additional images for you (especially those related to food or restaurants). 
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Learning Objectives 

Below is a list of the learning objectives for this session. Students should be able to independently 

complete each task. 

 

Content Knowledge: 

 communicate ideas and information to persuade the reader to invest money 

 organize information using a letter format 

 proofread their work and make the necessary edits 

 use correct spelling, grammar, and punctuation 

 recognize the features and structure of a professional business letter 

 

Technical Skills: 

 

Operating Environment 

 open a Word template 

 close a program  

 print a document 

 save a document to a folder 

 

Applied Technology 

 produce a professional letter using word processing tools 

 

Word Processing 

 type text 

 add clip art into an object frame 

 search the clip art gallery for a suitable company logo 

 insert a Microsoft Excel worksheet into a Microsoft Word document as an object 

 resize clip art and objects 

 select letter salutation and closing from a drop down menu 

 select text 
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Assignment 5: Professional Letter 

 

 

Open the Professional Letter Template 

 To open the template, double click on the shortcut to the Entrepreneur folder 

OR ask your teacher how to get to the folder. 

 Double click Professional Letter to open the template in Microsoft Word.  

 

 

Add a Company Name 

 Triple click the mouse in the Company Name Here placeholder. 

 Type the Restaurant Name. 

 Press ENTER to place the cursor below the text. 

 

 

Add a Company Logo 

 Open the Microsoft ClipArt Gallery by selecting from the Insert menu Picture and then 

Clip Art. 

 In the Search for: box type a keyword that 

describes the type of image you are looking for. 

For example, pizza, taco, steak, or seafood. 

 Press Go to display search results. 

 Use the scroll bar on the right edge of the clip art 

pane to look through the results. 

 To insert a picture click on it once. 

 Close the ClipArt Gallery window by clicking the 

Close button (X) in the corner of the title bar. 

In order to open your restaurant, you need a lot of money. 

You need to buy furnishings, appliances, and food. Also, 

you must hire cooks and waitresses. To borrow the 

necessary money, you are going to write a letter to 

investors asking them to help fund the building of the 

restaurant. Convince your family, friends, and bankers that 

you have a successful, well planned idea for your business! 
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Resize the ClipArt 

 Click on the clip art once to select it. 

 

 To increase or decrease the size, place the mouse pointer over a corner handle. 

 Click and drag the mouse inward to reduce the size of the object. Or, click and drag the 

mouse outward to increase the size of the object. 

 Release the mouse when the object is the desired size. 

 

 

Add a Return Address 

 Click the mouse pointer in the placeholder [Click here and type return address]. 

 Type an address (real or fictional) for the location of the restaurant. 

 
 

 

Add the Recipient's Address 

 Click the mouse in the placeholder [Click here and type recipient's address]. 

 Type the school's address or make up a fictional one. 

 
 

Change Salutation 

 Right click on the words Dear Sir or Madam: 

 Choose an alternate greeting from the list. 
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Insert Microsoft Excel Worksheet 

 Place the cursor below the preformatted text in the body of the professional letter by 

clicking the mouse pointer at this location. 

 

 From the Insert menu, select Object. 

 Click the Create from File tab. 

  
 

 Click the Browse button. 

 Look in the Entrepreneur folder and select My Survey from the Browse dialog box. 

 
 

 Click the Insert button. 

S
A
M

P
LE



PROFESSIONAL LETTER 

 

2-8 TECHNOKIDS INC. 

 With the Create from File dialog box redisplayed, click OK to add the Excel document. 

 
 

 To resize the worksheet click the object once to select it. 

 Place the mouse pointer over a corner handle and drag inward to reduce the size of the 

object. 

 Your work will look similar to this: 

 
 

 

Type the Body of the Letter 

 Triple click the mouse on the body text Type your letter… 

 Begin typing the new information. The selection is replaced with new text. Include the 

following information: 

 A reason for writing the letter (to request investment capital). 

 An explanation describing the uniqueness of the restaurant and how it will attract 

customers. 

 An explanation of the survey results. 
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Add a Letter Closing 

 Right click on Sincerely at the bottom of the letter. 

 Choose a closing from the list. Now press ENTER. 

 

 

Add a Signature 

 Press the CAPS LOCK key on the keyboard. 

 Type the Name of the Restaurant. 

 Press the CAPS LOCK key on the keyboard to turn off the feature. 

 Click in the placeholder [Click here and type your 

name]. 

 Type Student Name. 

 Click in the placeholder [Click here and type your job 

title]. 

 Type a Job Title such as; President, Founder, CEO, or 

Manager. 

 

 

Save the Document as Investment Letter 

 From the File menu, select Save or click the Save button on the Standard 

toolbar.  

 Click the Save in arrow and locate the Entrepreneur folder. 

 Change the document name from Professional Letter to Investment Letter. 

 Click Save. 

 
 

Print the Letter 

 Click the Print button on the Standard toolbar. 

 Give the printed letter to your teacher. 

 

Close Microsoft Office Word 

 To close Microsoft Word, click the Close button. 
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SESSION 2 REVIEW 
 

From the list below, write the names of the parts of a business letter in the boxes.  

 

 

Pizza Pete 

 
 

February 10, 2009 44 Aromatic Avenue 

 Hamilton, ON L8R 4Y0 

Phone: 905.829.9990     Fax: 905.829.9999 

 

John Knox Christian School 

2232 Sheridan Garden Drive 

Oakville, ON 

L6J 7T1 

 

Dear Sir or Madam: 

 

I would like to start up my own pizza restaurant. I have surveyed the residents of my 

community and discovered that 33% of respondents preferred pizza. Where as only 

29% want Mexican cuisine, 17% prefer Italian cuisine, 13% would like to eat at a 

steakhouse, and a small 8% would eat seafood. The results of the survey are 

displayed in the chart below: 

 

4

3

7

2

8

Total Number 

of People

Business Survey

Mexican Cuisine

Seafood

Pizza

Type of Restaurant 

Cuisine

Italian Cuisine

Steakhouse

Restaurant Cuisine Preferences

17%

13%

29%

8%

33%

Italian Cuisine Steakhouse Mexican Cuisine Seafood Pizza

 
 

I require money to start up my business venture. I would like you to invest in my 

business idea of running a pizza restaurant. My restaurant would be unique, as it 

would allow customers to choose from various toppings, crusts, and sizes of pizza. 

 

Respectfully yours, 

PIZZA PETE 

 

Christa Love 

President 

 

Return 

Address 

Date 

Salutation 

Parts of a Letter: 

 
  Body 

  Signature 

  Company Name 

  Return Address 

  Closing 

  Date 

  Recipient‟s Address 

  Salutation 

Recipient‟s 

Address 

Company 

Name 

Closing 

Signature 

Body 

S
A
M

P
LE



PROFESSIONAL LETTER 

 

2-12 TECHNOKIDS INC. 

 

 

 

S
A
M

P
LE



TECHNOENTREPRENEUR SESSION 2 

 

TECHNOKIDS INC. 2-13 

SESSION 2 SKILL REVIEW 
 

Business Letter from a Pet Shop 

 
 

Open the Professional Letter Template 

1. Double click on the TechnoEntrepreneur shortcut OR ask your teacher how to get to the 

Entrepreneur folder. 

2. Double click on the Professional Letter template. 

 

Add Pet Store Information 

3. Make up a name for the pet store and write it in the Company Name placeholder. 

4. Add a company logo from the Clip Art Gallery. 

5. Make up a return address for your pet store. 

6. Type in a date. 

7. Since you will be sending the same letter to many neighbors, click on the [Click here and 

type recipient’s address] placeholder and delete the words. 

 

Announce the Pet Store Opening 

8. In the body of the letter, tell the neighbors about the pet store. Include: 

 types of animals, such as puppies, fish, birds 

 products you sell, such as flea collars, toys for kittens, and hamster food 

 services you provide, such as dog washing and clipping 

 date of the grand opening 

 store location and hours 

 other important information that will encourage customers to visit your store  

 

Complete Letter Closing and Signature 

9. Right click on the closing and choose one from the list. 

10. Add your name and job title. 

 

Print Letter 

11. Proofread your work and edit it carefully. 

12. Save the letter with the name Grand Opening. Print the letter. 

You have just opened a new pet shop. You would 

like to let the customers and other businesses in the 

neighborhood know about the new store, so you are 

going to write an announcement about your grand 

opening.  
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Pete’s Pets 

 
 

February 10, 2009 

Dear Sir or Madam: 

We are thrilled to announce the opening of a great new pet store in your area! Pete’s Pets is a 
brand new business at 15 Forest Road in Hammondville. We would like to invite you and your 
whole family to our grand opening on November 1, 2005 from 9 am until 8 pm. Opening Day will 
feature a clown creating balloon animals for the kids, free popcorn and soft drinks, and lots of 
prizes for the best dressed pets! Join us for a fun filled day. 

Pete’s Pets will carry a complete line of popular pets, accessories, and pet food. We feature a 
puppy petting area, adorable kittens to adopt, a large variety of cuddly hamsters and gerbils, and 
many varieties of beautiful song birds. If you would like to purchase a new pet for your family or just 
need toys, food, leashes, cages or any supplies for your favorite animals, come and see our great 
selection. We will have a veterinarian on the premises on opening day to answer your questions or 
provide helpful advice. 

Our regular business hours are: Monday to Friday 9 am to 8 pm and Saturday 9 am to 6 pm. 

We look forward to meeting you and supplying you with all of your pet needs. 

 

Sincerely yours, 

Christa Love 
Manager and Owner, Pete’s Pets 

To see an example of a completed 

Grand Opening letter, view the sample 

file in the Session 2 Skill Review folder. 

15 Forest Road 
Hammondville, Ontario 
Canada K7T 2B5 
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SESSION 2 EXTENSION ACTIVITY 
 

Design a Menu 

 

One of the first and most important tasks you need to do when planning 

your new restaurant is to create the menu. The menu should: 

 

 attract customers 

 describe the dishes in detail and make them sound delicious 

 encourage people to try new foods 

 contain a variety of main dishes, beverages, and desserts  

 list prices 

 

Design a menu, listing a minimum of 6 main dishes. Be sure to include 

the main ingredients in each dish. Use a variety of descriptive adjectives to make your menu 

items sound scrumptious!  

 

 
 

 

Helpful Hint: A thesaurus is a great help in finding descriptive words. You can use a book 

version of a thesaurus from your classroom or library, or use the thesaurus in Microsoft Word: 

 

 Select the word you want to replace. 

 From the Tools menu choose Language…Thesaurus. 

 A window appears on the right with a variety of synonyms. 

 If you find a word that fits, right click on it and choose 

Insert. The word is replaced in your writing. 

Pete’s Popular Pan Pizza 

 

 
 

Fresh, hand tossed buttery crust with our own herbed tomato sauce, spicy 

Italian pepperoni, topped with a blend of four luscious cheeses – smooth and 

silky Mozzarella, tasty Romano, full favored Parmesan, and zesty Cheddar. 

 

Small 4 slice - $4.99 

Medium 8 slice - $7.99 

Large 12 slice - $10.99 
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